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Q1. Answer: 

(a) CPU – It is the electronic circuitry within a computer that carries out the instructions of a 

computer program by performing the basic arithmetic, logical, control and input or output 

operations specified by the instructions. It is also called a central processor, main processor 

or just processor, is the electronic circuitry that executes instructions comprising a computer 

program. 

  

(b) Keyboard – It is a peripheral input device which uses an arrangement of buttons or keys to 

act as mechanical level or electronic switches. Keyboard keys typically have a set of 

characters engraved or printed on them and each pair of key typically corresponds to a 

single written symbol. Keyboard is used as a text entry interface for typing text, numbers 

and symbols into application software such as a word processor, web browser or social 

media.   

  

(c) Mouse – A computer mouse is a hand-held pointing device that detects two dimensional 

motion relative to a surface. This motion is typically translated into the motion of a pointer 

on a display. Which allows a smooth control of the Graphical User Interface (GUI) of a 

computer. Computer mouse have one or more buttons to allow operation such as the 

selection of menu item on a display. Mouse often also features other elements, such as 

touch surfaces and scroll wheels, which enables additional control and dimensional input. 



  

(d) Monitor – Monitor is an output device that display information in pictorial or text form. A 

monitor usually comprises a visual display, some circuitry, a casing and a power supply. 

Monitors are connected to all the computers via VGA, Digital Visual Interface (DVI), HDMI, 

DisplayPort, USB-C, Low-voltage Differential Signaling (LVDS) or other proprietary 

connectors and signals. 

  

 

Q2. 

Ans.     Base on size capacity, computer are classified as follows – 

1. 1.Super Computer: These computers have thousands of processors because of their 

extraordinary speed, accuracy and processing power. Super computer are all suited 

for solving highly complex problems and huge amount of calculations. For example : 

JAGUAR, ROADRUNNER, etc. 

2. Main frame computer: These computers are very large often filling an entire room 

and can process thousands of millions of instructions per second. These computers 

are capable of supporting hundreds of thousands of users simultaneously. Some of 

the function performed by a main frame include flight scheduling, reservation and 

ticketing for an airline etc. For example: IBM main frames Z13, IBM system Z9 main 

frame 

3. Mini computers: Mini computers are much smaller than mainframe . Sometime 

reference to a midrange server or midrange computer. Midrange computers 

are usually used by small and medium sized business as their server. For 

example Apple iPad, CDC160A. 

4. Microcomputers: Micro computers are the most frequently used computer. It is also 

known as Personal Computer (PC). A micro computer is a small computer system 



designed to use by one person at a time. For example Desktop computer, 

Laptops. 

 

Q3. 

Ans.     Generation in computer technology is a change in technology a computer is being used. 

There are four Generation in computer. 

• In the first computer system vacuum tubes are used 

• Transistor are used in second generation  

• Integrated circuit technology was used in third generation  

• In the fourth generation microprocessor are used  

 

Q4. 

Ans.  

                                  Volatile                               Non Volatile 

1. It is a computer storage that only 
maintain its data while the device is 
power. 

2. Example: RAM 
3. Primary memory has limited storage 

capacity and its volatile. 

1. It is a type of computer memory that has 
the capability to hold saved data if the 
power is turned off.  

2. Example: ROM Hard disk 
3. Secondary memory provide permanent 

storage of data. 

 

 

Q5. 

Ans. System software: It is a type software that is designed to run a computer hardware and 

application programs, software like operating system compilers, editor and drivers etc. come under 

this category. A computer cannot function without the presence of system software. 

Whereas  

Application software: It is a software created for a specific purpose used beyond user. It can be 

called as application or simply an app. 

Eg. Word processor, accounting app. Etc 

While 

Open Source Software (OSS): it is a type of computer software in which source code is 

released under a licence in which the copyright holder guard users right to study change and 

distribute the surface to anyone and for any purpose. Eg The Linux operating 

 

The step involved are 



1. We click the Microsoft office button 

2. We select new. The new document dialog box appears. 

3. We select blank document under the Blank and recent section. It will be highlighted 

by default. 

4. To save the document, we click again the Microsoft office button. 

5. We select save as – Word-Document. the save as dialog box appears. 

6.  Select the location where we want to save the document using drop down menu 

7. We enter the Name of the document and  

8. We click the save button. 

 

Q6(b). 

Ans.      Steps to change the font style 

1. We select the text that we want to modify. 

2. Lift click the drop down arrow next to the font style box on the home tab. The font 

style drop-down menu appears. 

3. We move the cursor over the various font styles. A live preview of the font will 

appear in the document. 

4. Lift click the font style we want to use. The font style will change in the document. 

 

 

Steps to change the font size 

1. We select the text we want to modify. 

2. Lift click the drop-down arrow next to the font size box on the home tab. The font size drop-

down menu appears. 

3. We move the cursor over the various font sizes. A live preview of the font size will appear in 

the document. 

4. Left click the font size we want to use. The font size will change in the document. 

 

 

 

              Steps to change the font colour 

1. We select the text we want to modify. 

2. Left click the drop down arrow next to the font colour on the home tab. The font colour 

menu appear. 

3. We move the cursor over the various font colour. A little preview of the colour will appear 

in the document. 

4. Left click the font colour we want to use. The font colour will change in the document. 

 



 

Step to highlight (in yellow) the line that reads “need to get IMS’s address”. 

1. We select the line that need to get IMS’s address. 

2. We click the highlight command and select yellow colour in the font group on the home tab. 

  

 

Q7. 

Ans.        MS Word 

            MS Word is a widely used commercial word processor develop by Microsoft. 

MS Word is application software, which is capable of 

• creating, 

• editing, 

• saving, and 

printing any type of document 

 

            The steps involve are as follows: 

1. We click the Microsoft office button. 

2. We select new. The new document dialog box appears. 

3. We select blank document under the blank and recent section. It will be highlighted by 

default. 

4. We click create. A new blank document appears in the word window. 

5. We create the given documents from the question. 

6. We select the text “MS Word” and change the font size by clicking on the font size box on the 

home tab. 

7. We select the text “MS Word”, to change the font colour into red by clicking on the font 

colour menu. 

8. We select the “word processor” and underline it by clicking the underline command in the 

font group on the home tab. 

9. We select the text “MS Word” to change the font style into italic by clicking the italic 

command. 

10. We select the text we want to format as a list and click the bullet command on the home tab. 

11. We change the font colour of the text “creating and saving” into blue and red respectively by 

clicking on the font colour command again we select the text “and” and cli8ck on strike 

through command. 

12. We select the text “printing any type of document” and change the font style into bold by 

clicking the bold command. 

13. We save the file name as “MS Word” by clicking the Microsoft office button and select save 

as. 

14. We select the location where we want to save the document using the drop down menu. 

15. We click the save button. 



 

 

Q8. 

Ans.        The steps involved    

1. We create given document in MS Word. 

2. We select the text where we want to format and click on the subscript and superscript 

command on the home tab. 

3. We save the file ‘equation’ by clicking the Microsoft office button and select save as. 

4. We select the location where we want to save the document using the drop down menu. 

5. We click save button.  

 

 

Q9. 

Ans.      the steps involved are 

1. We select the existing highlight text that we want to convert. 

2. We select the insert tab. 

3. We click the table command. 

4. We select convert text to table from the menu. If dialog box appears. 

5. We click ok. Then the text appears in a table. 

 

 

Q10. 

 

 

 

 

Ans.     The steps are: 

1. We place our insertion point in the document where we want the table to appear. 

2. We select the insert tab. 

3. We click the table. 

4. We drag our mouse over the diagram. Squares to select the number of columns and rows in 

the table. 

5. Left click on the mouse, and the table appears in the document. 

          

          

          

          

          



6. We enter the text into the table. 

Steps: 

1. Open MS-word and select the blank document. 

2. Type the require text. 

3. Place the cursor on the position where you want to add table. 

4. Click on the Insert Tab to insert a table. 

5. Then, click the Table command on tool bar. 

6. Click the Insert Table in dialog box. 

7. Choose the require numbers of rows and columns. 

8. Click on OK option and the table is finally inserted. 

 

 

Q11. Ans. 

Roll No Name Marks 

1 n1 60 

2 n2 70 

3 n3 80 

4 n4 90 

5 n5 40 

6 n6 50 

7 n7 77 

8 n8 44 

9 n9 88 

10 n10 55 
 

Q12. Ans. 

Roll No Name Marks 

1 n1 60 

2 n2 70 

3 n3 80 

4 n4 90 

5 n5 40 

6 n6 50 

7 n7 77 

8 n8 44 

9 n9 88 

10 n10 55 

   

 Total 654 

 Average 65.4 

     Highest 90 

 Minimun 40 
 



Q13. 

Ans. (a) Answer: 

➢ To modify column width of a worksheet: 

i. Select a column or a range of columns. 

ii. Select a Home tab and in the Cells group, select Format. 

iii. Click on Column width and type the width for column. 

iv. Select OK. 

➢ To modify the row height of a worksheet. 

i. Select a row or a range of rows. 

ii. Select a Home tab and in the Cells group, select Format. 

iii. Click on Row Height and type the height for row. 

iv. Select OK. 

➢ To delete rows and columns of a worksheet. 

i. Select the cell you want to delete within the column or row. 

ii. Select Home tab. And in cells group click on Delete Sheet Column or Row. 

                                                    OR 

i. Select the desire row or column. 

ii. Right-click and select Delete. 

 

Q13. (b) Answer: 

➢ Absolute Reference:  

An absolute reference in Excel means there is a fixed point of reference applied to a cell or a 

formula. This is so the return value will always stay the same no matter where the cell or 

formula moves to – within the same sheet or across different sheet. 

 

This refers to a fixed point of reference is a constant, and involves the use of dollar sign $ in 

the formula (i.e., everyone is to receive the same bonus payout, so the amount $1500 is 

constant in this situation). 

 

                        

Microsoft Excel 

97-2003 Worksheet
 

 

➢ Relative Reference: 

It is the default cell reference in Excel. It is simply the combination of column name and row 

number without any dollar ($) sign. When you copy the formula from one cell to another the 

relative cell address changes depending on the relative position of column and row. C1, D2, 

E4, etc. are examples of relative cell references. Relative references are used when we want 

to perform a similar operation on multiple cells and the formula must change according to 

the relative address of column and row. 

                   

                      

Microsoft Excel 

97-2003 Worksheet
 



This refers to a relative point of reference, is constantly changing and dollar sign ($) is absent 

in the formula (i.e., when each unit price and quantity are difference variables, there’s no 

constant in the calculation).  

 

➢ Cell Address: 

A cell address is a combination of column letter and a row number that identifies a 

cell on a worksheet. 

For example, A1 refers to the cell at the intersection of column A and row 1; B2 

refers to the second cell in column B, and so on. 

         When used in formula, cell references help Excel find the values the formula 

should calculate. For instance, 

• To pull the value of A1 to another cell, you use this simple formula: 

=A1 

• To add up the values in cells A1 and A2, you use this one: =A1 

 

Q14.(a) 

Ans. Tools available to customize our PowerPoint presentation are:  

1. Perspector. 

2. PivotViewer. 

3. Autodesk 3DS Max 

4. VisualBee PowerPoint Add-In 

5. SmartArt 

6. Animation and Transitions 

7. Wordle  

8. Cacoo 

Q14 (b) 

➢ Ans. To open blank presentation: 

I. Open PowerPoint presentation using ‘Run’ command (window key + R). 

II. Select the ‘Blank Presentation’. It is opened. 

➢ Save the Presentation as Lab1.pptx.: 

I. Select the ‘File’ on Tab bar. 

II. Click on ‘Save As’ option. 

III. Click on document/Desktop as your choice. 

IV. Type the name ‘Lab1.pptx’. 

V. Click the ‘Save’ button. 

 

➢ Add a Title to the first slide: the name of your college. 

i. Left click on the ‘Click to Add Title’ section on the first slide. 

ii. Type the name of your college. 

➢ Type your first name and last name in the subtitle section: 

i. Left click on the ‘Click to Add Subtitle’ section. 



ii. Type your first name and last name. 

➢ Add a New slide which has a Title and content. 

i. Select the Home tab. 

ii. Click on the dropdown button of the ‘New Slide’ on toolbar. 

iii. Select the slide having ‘Title and Content’. It is added. 

 

 

Q15.  

➢ Ans. Title slide and bullet list: 

i. Open PowerPoint Presentation. 

ii. Select the Home tab. 

iii. Click at the dropdown button on ‘New Slide’ at toolbar. 

iv. Select the slide having Title slide and Bullet list. 

➢ Inserting Excel sheet: 

i. Open the slide where you want to insert the Excel Sheet. 

ii. Select the ‘Insert tab’. And click on ‘Object’ on tool bar. 

iii. Select the ‘Microsoft Excel Worksheet’ object type. 

iv. Click the ‘OK’ button. 

➢ ClipArt and Text: 

i. Select the Insert Tab. 

ii. Select the ‘Pictures’ or ‘Online pictures’ on tool bar. 

iii. Choose the appropriate art for the topic. 

iv. Click on the ‘Insert’ button. 

➢ Slide show effects: 

i. Select ‘Design Tab’ for Themes, Variants and Slide size. 

ii. Select ‘Transition Tab’ for Cut, Fade, Push, Wipe, Split, Reveal, Shape, Flash, 

etc. for slide effects. 

 

 

 

Q16. 

Ans.         

     

                      Machine Language                       High level language 

A computer programming language consisting 
of binary instructions which a computer can 
respond directly. 

A high level language is a programing language 
that enable development of a programing a 
much more user  friendly programming 
content. 

 



 

 

Q17. 

Ans. 

1.  char- It is the most basic data type in c programming language. It stores a single character 

and requires a single byte of memory in almost all compilers. 

2. Int.-As the name suggests an int. variable is used to store an integer. 

3. float- It is used to store decimal numbers (numbers with floating point value). 

4. Double- it is used to store decimal numbers (numbers with floating point value is high as 

compare to float. 

 

  

Q18a. 

Ans.   X=20/5*2+30-5 

            =4*2+30-5 

            = 8+30-5 

            =38-5 

            = 33 

 

 

(b)      Y = 30-(40/10+6) +10 

              = 30-10+10 

              = 30 

 

 

(c) Z= 40*2/10-2+10 

 

 

Q19. 

Ans.  

a) If – else statement: 

If statement can be followed by an optional else block of statements, which executes when 

the boolcam expression is false.  

        Syntax 



 

 

 
 

 

 

 

 

 

 

 

          In this type of construct, if the value of test-expression is true, then the true block of 

statements will be executed. If the value of test expression is false, then the false block of statement 

will be executed. In any case, after the execution, the control will be automatically transferred to the 

statements appearing outside the block of If. 

(b) for loop is similar to While loop. Basic syntax of for loop is as follows 

 

For (expression 1; expression 2; expression 3) 

       { 

        Block of statement 

        } 

 

In the above syntax. 

• Expression 1 – Initializes variables. 

• Expression 2 – conditional expression, as long as this condition is true, loop will keep 

executing. 

• Expression 3 – expression 3 is the modifier which will increase or decrease the value of 

variable. 

 

            

(c)   While loop. 

Basic syntax of while loop is as followed 

         While (condition) 

                             Single statement. 

if (test-expression) 

{ 

    True block of statements 

}     

Else 

{ 

    False block of statements 

} 

Statements; 

 

 

 



OR 

        While (condition) 

        { 

          Block of statements 

         } 

 

(d) do – while loop 

        Unlike for and while loops, which test the loop condition at the top of the loop, the do-while 

loop in C programming checks its condition at the bottom of the loop. A do-while loop is similar to a 

while loop, except the fact that it is guaranteed to execute at least one time.  

           The syntax of a do-while loop in C programming language is – 

 

 

 

              Notice that the conditional expression appears 

at the end of the loop, so the statement(s) in the 

loop executes once before the condition is tested. If the condition is true, the flow of control jumps 

back up to do, and the statement(s) in the loop executes again. This process repeats until the given 

condition becomes false. 

             A do-while loop is a kind of loop, which is a kind of control statement. It is a loop with the 

test at the bottom, rather than the more usual test at the top. This kind of loop is most often used 

when the test doesn’t make any sense until the statement have been performed at least once.  

 

 

 

Q20. 

Ans. 

A) Ans. IMS Ghaziabad 

B) IMS Ghaziabad  

IMS Ghaziabad 

C) Largest number is 100 

 

do { 

   statement(s); 

} while (condition); 


